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QUESTION NO: 1

You work as an Office Assistant for Peach Tree Inc. Your responsibility includes creating sales incentive report of all sales
managers for every quarter. You are using Microsoft Excel to create a worksheet for preparing the report. You have inserted
the sales figures of all sales managers as shown in the image given below:
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7 IName January|February |March |Quarter Sale|Incentive
| 8 |Mark 52.000.00 $2,450.00| 52.700.00 $7,150.00
9 |David $2,100.00 $2,200.00| 52,300.00 36,600.00

10 |Mariah $1,550.00 22.150.00| $2,310.00 $6,410.00

11 | Sarah 52.300.00 $2,700.00| $3.100.00 S8,100.00

12 |Sasha $2.500.00 $2,840.00]| 53.400.00 58,740.00

You have to calculate the first quarter incentives for all sales managers. The incentive percentage (provided in cell B3) is
fixed for all sales managers. The incentive will be calculated on their total first quarter sales. You have to write a formula in
the cell F8. Then you will drag the cell border to the cell F12 to copy the formula to all the cells from F8 to F12. In the first
step, you select the F8 cell. Which of the following formulas will you insert to accomplish the task?

A. =&B&3/100 * E8
B. =B3/100 * E8

C.=B3/100 * &E&8
D. =$B$3/100 * E8
E. =B3/100 * $E$8

ANSWER: D

Explanation:

In order to accomplish the task, you will have to insert the following formula:

=$B$3/100 * E8

According to the question, the formula will be inserted in cell F8 and then the cell's border will be dragged to the F12 cell.
Furthermore, the incentive percentage is fixed for all sales managers and the value is provided in the cell B3. You will have

to insert a formula that refers to the B3 cell as an absolute reference. For this you will have to type currency symbol ($)
before the row hame and column number. In order to accomplish the task, type the following formula in the cell F8:
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=$B$3/100 * E8

When absolute reference is used for referencing a cell in a formula, dragging cell's border to another cell does not change
the cell's reference.

Answer options B and E are incorrect. This formula references the B3 cell as a relative reference. After inserting the formula,
when the cell's border is dragged, it will change the cell reference relatively.

Answer options A and C are incorrect. Ampersand symbol (&) is not used for referencing cells in Excel.

QUESTION NO: 2

You work as an Office Assistant for Media Perfect Inc. You are creating a report in Microsoft Excel 2010. The report
worksheet will include the sales made by all the sales managers in the month of January.

A, B
1 Sales Report

2

J
L]

4 David $1,000.00
5 Mariah $1,700.00
6  Mark $2,500.00
7 Sarah $2,200.00
g Sasha $3,100.00
7 Total $10,500.00,

In the worksheet, you are required to place a pictorial representation displaying the percentage of total sales made by each
sales manager in January. Which of the following charts will you use to accomplish the task?

A. Bar
B. Line
C. Column

D. Pie

ANSWER: D

Explanation:

In order to accomplish the task, you will have to insert a pie chart in the worksheet. Excel provides a pie chart facility to
display data that is arranged in one column or row on a worksheet. Pie charts display the size of items in one data series,
proportional to the sum of the items.
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QUESTION NO: 3

You work as an Office Assistant for Media Perfect Inc. You have created a spreadsheet in Excel 2010 and shared it with the
other employees of the company. You want to protect the worksheet and locked cells by permitting or prohibiting other
employees to select, format, insert, delete, sort, or edit areas of the spreadsheet. Which of the following options will you use
to accomplish the task?

A. Mark as Final
B. Encrypt with Password
C. Protect Current Sheet

D. Protect Workbook Structure

ANSWER: C

Explanation:
The various Protect Workbook options are as follows:

1. Mark as Final: This option is used to make the document read-only. When a spreadsheet ismarked as final, various
options such as typing, editing commands, and proofing marks are disabled or turned off and the spreadsheet becomes
read-only. This command helps a user to communicate that he is sharing a completed version of a spreadsheet. This
command also prevents reviewers or readers from making inadvertent modifications to the spreadsheet.

2. Encrypt with Password: When a user selects the Encrypt with Password option, the EncryptDocument dialog box appears.
In the Password box, it is required to specify a password. Microsoft is not able to retrieve lost or forgotten passwords, so it is
necessary for a user to keep a list of passwords and corresponding file names in a safe place.

3. Protect Current Sheet: This option is used to select password protection and permit or prohibitother users to select,
format, insert, delete, sort, or edit areas of the spreadsheet. This option protects the worksheet and locked cells.

4. Protect Workbook Structure: This option is used to select password protection and selectoptions to prevent users from
changing, moving, and deleting important data. This feature enables a user to protect the structure of the worksheet.

5. Restrict Permission by People: This option works on the basis of Window Rights Managementto restrict permissions. A
user is required to use a Windows Live ID or a Microsoft Windows account to restrict permissions. These permissions can be
applied via a template that is used by the organization in which the user is working. These permissions can also be added by
clicking Restrict Access.

6. Add a Digital Signature: This option is used to add a visible or invisible digital signature. ltauthenticates digital information
such as documents, e-mail messages, and macros by using computer cryptography. These signatures are created by
specifying a signature or by using an image of a signature for establishing authenticity, integrity, and non-repudiation.
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QUESTION NO: 4

You work as an Office Assistant for Tech Tree Inc. You have created a report in a workbook in Microsoft Excel 2010. You
have a number of PivotTables in a single report. You want to apply the same filter to all of those PivotTables. For this
purpose, you are required to create a slicer in one PivotTable and share it with other PivotTables. Which of the following
steps will you take to accomplish the task?

Each correct answer represents a part of the solution. Choose all that apply.

A. In the Insert Slicers dialog box, select the check box of the PivotTable fields for which you want to create a slicer.

B. Click Insert Slicer in the Sort & Filter group on the Options tab.

C. Hold down CTRL, and then click the items on which you want to filter.

D. Select the Macro enabled checkbox of the PivotTable fields for which you want to create a slicer in the Insert Security
dialog box and then click OK.

E. Click anywhere in the PivotTable report for which you want to create a slicer.

ANSWER: ABCE
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QUESTION NO: 5

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. Some employees have
changed some data in the worksheet of the company. You want to identify changes that were made to the data in the
workbook and then take a decision whether to accept or reject those changes. For this purpose, it is required to access and
use the stored change history.

Which of the following will you use to accomplish the task?

Each correct answer represents a complete solution. Choose all that apply.
A. History tracking

B. Onscreen highlighting

C. Slicer-enabled highlighting

D. Reviewing of changes

ANSWER: ABD

Explanation:
The following ways are provided by Excel to access and use the stored change history:

1. Onscreen highlighting: It is used when a workbook does not contain many changes and a userwants to see all changes at
a glance.

2. History tracking: It is used when a workbook has many changes and a user wants to investigatewhat occurred in a series
of changes.

3. Reviewing of changes: It is used when a user is evaluating comments from other users. Answeroption C is incorrect. This
is an invalid answer option.

QUESTION NO: 6

You work as an Office Manager for Blue Well Inc. The company has a Windows-based network. You have two budget
situations in which one is the worst case and the other is the best case. You want to create both situations on the same
worksheet and then switch between them with the change in requirements. Which of the following will you use to accomplish
the task?

A. Goal Seek

B. Data table

C. Scenario

D. Solver add-in

ANSWER: C

Explanation:
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A scenario is defined as a type of what-if analysis tools. It is a set of values saved by Excel and can be substituted
automatically in cells on a worksheet. A user can create and save different groups of values on a worksheet and then switch
to any of these new scenarios to view different results. Scenario reports are not automatically recalculated. If the user
changes the values of a scenario, those changes will not be displayed in an existing summary report and he must create a
new summary report to show the reflection of the changed report. Answer option A is incorrect. Goal Seek is defined as a
type of what-if analysis tools. It is used if a user knows the result that he wants from a formula, but he is not sure what input
value the formula needs to get that result. It works with only one variable input value.

Answer option D is incorrect. The Solver add-in is used if a user knows the result that he wants from a formula, but he is not
sure what input value the formula needs to get that result. It is used for more than one input value. It works with a group of
cells related to the formula in the objective cell. Answer option B is incorrect. A data table is used to see all the outcomes in
one place. It is defined as a type of what-if analysis tools. It is used if a user has a formula that uses one or two variables or
multiple formulas that all use one common variable. It is used to examine a range of possibilities at a glance and since the
user focuses on only one or two variables, results are easy to read and share in tabular form. If automatic recalculation is
enabled, it is possible to recalculate the data in data tables immediately and as a result, the user always gets fresh data.

QUESTION NO: 7

Rick works as an Office Assistant for Tech Perfect Inc. The company has a Windows-based network.

Rick is creating a project through Microsoft Excel 2010. The project on which he is working has 98 project tasks and 57 team
members. Rick wants to check the progress of his project quickly and easily. Which of the following will Rick use to
accomplish the task?

A. Gantt Chart Template
B. Form control
C. Trust Center

D. Accounting template

ANSWER: A

Explanation:

The Gantt Chart Template Deluxe Edition for Excel is used to generate quick and easy Gantt charts that define the progress
of a user's projects containing up to 100 project tasks and team members. Answer option B is incorrect. A form control is an
original control that is compatible with old versions of Excel, beginning with Excel version 5. 0. It is designed for use on XLM
macro sheets. It can be used when a user wants to simply interact with cell data without using VBA code and when he wants
to add controls to chart sheets. By using form controls, the user can run macros. He can attach an existing macro to a
control, or write or record a new macro. These controls cannot be added to UserForms, used to control events, or modified
to run Web scripts on Web pages. Answer option D is incorrect. The accounting template is used for numbering months of a
financial year to period numbering. It is used to compare month to month, actual v budget, quarter to quarter, year to year
variances. It is the initial point for other reports that need the use of months. Answer option C is incorrect. Trust Center is
where a user can find security and privacy settings for Microsoft Office 2010 programs.

QUESTION NO: 8 - (HOTSPOT)

HOTSPOT
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You work as a Sales Manager for Rainbow Inc. You are working on a report in a worksheet in Excel 2010. You want to insert
flow-chart in the sheet. Mark the option that you will choose to insert flow- chart symbols in the report. In order to accomplish
the task, you will have to choose the Shapes option. Shapes are simple objects provided by Microsoft Office to add them to a
document. A single shape or combined multiple shapes can be inserted in the document. The Office includes simple shapes,
such as lines, basic geometric shapes, arrows, equation shapes, flowchart shapes, stars, banners, and call outs. Users can
add text, bullets, numbering, and Quick Styles to these shapes after inserting them in the document. Take the following steps
to add a shape in a document:

Hot Area:
Home Insert Fage Lawout Formulas Data Fewiauw Wiy
| 3| - | J Elgl LY shapes - “ e Line = gy Area - I Line — Q
[ B Fiall B = . = ==
el B ([ M 2 smartart & Pie = | Scatter - ks Column ==t &
PivotTable Table Pickure Clip — Column g Slicer | Hyperdink
. At sk Screenshot = - EsBars () OthercCharts = [RiWin/Loss
Tables Tlustrations [ Charts - | Sparklines [ Filter [ Links
ANSWER:
Home Insert Page Layout Formulas Bata Flewiewy Wiews
.13 == | Elgl GJ shapes - a o |Line = gy Area = A Line e}
| = Fkail |1 = =
= === R J el 2| Smartart & Ple v | [0 Seatter v WL Calumn
PivotTable Table @ Pidure Clip = Column e e Slicer | Hyperink
. At s Screenshot= | 0w BplBare L )/Other Charts +  [“iAlindloss
Tables Tlluistrations Charts - Sparklines Filter Links
Explanation:
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1. Click on the Shapes option in the [lustrations group an the Insert tab. This will open the list of shapes available in Microsoft Office.
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QUESTION NO: 9

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. You want to make a slicer
available for use in another PivotTable. Which of the following steps will you take to accomplish the task?

Each correct answer represents a part of the solution. Choose all that apply.
A. Click the Insert Slicer arrow, and then click Slicer Connections on the Options tab in the Sort & Filter group.

B. In the Slicer Connections dialog box, clear the check box of any PivotTable fields for which you want to disconnect a
slicer.

C. In the PivotTable Connections dialog box, select the check box of the PivotTables in which you want the slicer to be
available.

D. Click the slicer that you want to share in another PivotTable.

ANSWER: CD

QUESTION NO: 10
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You work as an Office Assistant for Tech Perfect Inc. You are working in a spreadsheet. You use a function in one cell and it
works perfectly but when you attempt to copy the function down to other rows, you get the #REF error. Which of the following
are the reasons that are causing the above problem?

Each correct answer represents a complete solution. Choose all that apply.

A. You are inserting a new column, next to a column that is already formatted as text.

B. Excel is trying to reference an invalid cell.

C. The lookup_value or the array you are searching resides in a cell containing unseen spaces at the start or end of that cell.

D. You are referencing an entire worksheet by clicking on the grey square at the top left of the worksheet.

ANSWER: BD

Explanation:

The Lookup Function Won't Copy Down to Other Rows error occurs when a user uses a function in one cell and it works
perfectly but when he attempts to copy the function down to other rows, he gets the #REF error. The #REF! Error arises
when Excel tries to reference an invalid cell. This error occurs if the user has referenced an entire worksheet by clicking on
the grey square at the top left of the worksheet. For Excel, this reference range is 1 to 1048576. Since the references are
Relative References, Excel automatically increases the row references when this cell is copied down to other rows in the
spreadsheet.

Answer option C is incorrect. The Failure to Look Up Values in Excel error occurs when a user gets an unexpected error
while trying to look up or match a lookup_value within an array and Excel is not able to recognize the matching value. If the
lookup_value or the array the user is searching resides in a cell, the user can have unseen spaces at the start or end of that
cell. This will create the situation where the contents of the two cells that the user is comparing look the same but extra
spaces in one of the cells cause the cells to have slightly different content. The other reason is that the contents of the cells
that are being compared may have different data types.

Answer option A is incorrect. The Excel Won't Calculate My Function error occurs when a user types in a function and
presses Enter; the cell shows the function as the user typed it, instead of returning the function's value. The reason that
causes this problem is that the cells containing the formula are formatted as 'text' instead of the 'General' type. This happens
when the user inserts a new column, next to a column that is already formatted as text due to which the new column inherits
the formatting of the adjacent column.
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